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Preface

This guide is designed to be used as a manual of operations for the HP SQM Solution
Service Designer tool that is used to design and modify service models in UML, and
translate service models from UML to BSM-recognized models and vice versa.

This document also presents and explains the various concepts regarding different
components that are included in the Service Designer tool.

The guide is organized in a manner that the user is initially given an overview of the
Service Designer tool and introduction of each major component integrated in the tool.
The guide then uses the high-level overview to drill down and explain each component
and the various stages of the Service Designer workflow using real-life examples.

Intended Audience
This document is intended for the following users:
e  SQM Solution user

e  SQM Solution administrators.

Abbreviations and Acronyms

The following table describes the abbreviations and acronyms used in this document.

BSM Business Service Management
CI Configuration Item

CIT Configuration Item Type

DDM Discovery & Dependency Mapping
DDP Discovery & Dataload Pack
DSA Data Source Adapter

HI Health Indicator

KPI Key Performance Indicator
MA Monitoring Adapter

0SS Operations Support System
RTSM Run-Time Service Model

SA Service Adapter

SID Shared Information Data

SiS SiteScope
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SMF

Service Management Foundation

SQM Service Quality Management
TMF TeleManagement Forum
uCMDB Universal Configuration Management Data Base

Associated documents

The HP Business Availability Center and SiteScope documents are available at:
http://support.openview.hp.com/selfsolve/manuals

Additional SQM Solution materials (like the SQM Solution product briefs) and
information about SQM Solution updates are available at: http:/www.hp.com/cms

Typographic Conventions

This document uses the following conventions to identify special information:

@ Information Type/Example

[ ] (square Interface components requiring user actions e.g. Buttons.
brackets) Ex: Click [Finish] to complete the Import wizard.

() [round . . . ) .

brackets] Supplementary information £x: Configuration Item (CI).
Bold type Fields names, menus, window pane names

Ex of menus: Admin - Service Level Management >
Repository.

Italic type

Important information and/or concepts.
Ex: The output is an .XMI file.
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Symbols Used in this Guide

Symbols Information

Note

Draws your attention to additional information about a
4 software function/feature.

Important

Draws your attention to important information regarding the
proper usage of a software function/feature.

Caution
Draws your attention to an important warning.

Support

Please visit our HP Software Support Online Web site at:
http://support.openview.hp.com/support.jsp

HP Software online software support provides customer self-solving capabilities. It
provides a fast and efficient way to access interactive technical support tools needed to
manage your business. As a valued support customer, you can benefit by using the
support site to:

Search for knowledge documents of interest
Submit enhancement requests online

Download software patches

Submit and track progress on support cases
Manage a support contract

Look up HP support contacts

Review information about available services
Enter discussions with other software customers

Research and register for software training.
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Chapter 1

Service Designer
Overview

The SQM Service Designer solution is designed to aid the user in creating, manipulating
and deploying service models with utmost ease and precision. Service Designer employs
two main processes, the first process involves designing the service model using a
conventional third party UML modelling tool (Borland Together 2008 Release 3), and then
converting and deploying the model in BSM. The second process involves manipulating
existing BSM service models by importing a model in the UML modelling tool and then
modifying it. These processes and the various components of the SQM Service Designer
are discussed in more detail in the following sections.

1.1 Service Designer Components

The Service Designer Solution is composed of various independent components which are
used in different stages of the service design/modification process. In the first version of
the Service Designer, these components support the following model information:

e Definition of CI types and relationships
¢ Relationships between CI types
e Definition of Health Indicators (HI)
e Definition of Key Performance Indicators (KPI)
e Definition of Business Rules (BR)
The Service Designer components are discussed below in further detail.
a SQM Service Designer supports creation of HIs, KPIs and Business Rules. The

delivered HIs, KPIs and BRs by BSM and SMF 3.0 are included in a UML
workspace.

1.1.1 Telco Palette

A special customized Telco Palette is integrated in the UML modelling tool (Borland
Together 2008) and appears as part of the standard UML design Palette. The Telco
Palette contains several UML stereotypes specific to SQM Solution modelling. The Telco
Palette is a user-friendly feature that allows the user to define a service model using the
following stereotypes recognized in BSM:

CIT ATTRIE ATTH
e CI Type (CIT , CIT_ATTRIBUTE , ATTRIBUTE_OVERRIDE 0o+T)
e CMDB_RELATION , CALCULATED_LINKS_TRIPLET +# , Generalization

e Business Rule (BR_DASH BR Br_sim BER,
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e Health Indicators (HI DASH HI g1 spm H
e KPI (KPI_ DASH WPl KPI SL.M 'KPI)

HI HI
« HI Assignment (HI_CONFIGURATION cant, HI_ASSIGNMENT DASH A%,
HI_ASSIGNMENT SLM A%)

For more information about using the Telco Palette, refer to Chapter 2
« Designing Service Models.

1.1.2 Transducer

Transducer is a command-line tool which is used to convert a UML model file to a
BSM/RTSM model file, which can then be imported and deployed in RTSM UI of BSM, as
required. The input for the Transducer process is an “. XMI” file exported by the UML
modelling tool (Borland Together 2008 Release 3), and the output is a “.ZIP” file
containing CIT definitions which may be imported using RTSM UI of BSM and a “XML”
file containing HI, KPI, BR and Propagation Rule definitions which may be imported
with Content Pack UI of BSM.

For more information about working with the Transducer tool, refer to Chapter
“ 3 Deploying Service Models in BSM.

1.1.3 Reverse-Transducer

Reverse-Transducer is also a command-line tool similar to the Transducer. The main
function of this tool is to convert a model file and Content Pack file to a UML model file,
which can then be imported and deployed in the UML modelling tool (Borland Together
2008 Release 3). The input for the Reverse-Transducer process is a set of model (”.ZIP”)
files, containing definitions retrieved from BSM/RTSM, and a set of Content Pack
(“XML”) files. Its output is an .XMI file which may simply be imported in the UML
modelling tool.

~ For more information about working with the Reverse-Transducer tool, refer to
4 Chapter 4 Importing Service Models in UML.

1.2 Service Designer Workflows

As we have discussed earlier that the Service Designer essentially employs two processes
both with different inputs and outputs, this section presents a depiction for the workings
of these processes.

1.2.1 Reverse-Transducer Workflow

The Reverse-Transducer workflow involves retrieving and manipulating existing BSM
service models by converting and then importing a model in the UML modelling tool
(Borland Together 2008 Release 3).
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BSM Admin Ul

] ——

RTSMAdminUl .

SELECT uCMDB PRackage SELECT Content Pack
EXPORT Content Pack

EXPORT Package
everse @

IMPORT
.. MODELING
.. .. XMI FILE

i Designe;—

'\ ’ For more information about the Reverse-Transducer workflow, refer to Chapter
- 4 Importing Service Models in UML.
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1.2.2 Transducer Workflow

The Transducer workflow involves designing a new service model or modifying an
existing model imported from BSM, using a conventional third party UML modelling tool
(Borland Together 2008), and then converting and deploying the model in BSM/RTSM
and HI, KPI, BR in BSM/Content Pack.

~SQM Seryice Designer

EXPORT
.. MODELING
.. .. XMI FILE

Transducer

</>

IMPORT Content Pack

o

jC;Q,;J%eﬁvﬂlaek Admin U=

g —— ::v
= BSM Admin-Ul

=S

(= e

'\ ’ For more information about the Transducer workflow, refer to Chapter 3
4 Deploying Service Models in BSM.
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Designing
Service Models

Chapter 2

This chapter contains the definition and usage of the Telco Service Designer Palette and
the procedure of creating a service model in Borland Together using the several available

stereotypes specific to Telco SQM Solution modelling.

2.1 Using the Telco Palette

The Telco Service Designer Palette is integrated to the UML modelling tool (Borland
Together 2008 Release 3), and is designed to provide accessibility to the user for creating
service models that are recognized in BSM. The following figure shows the stereotypes

and their associated icons available in the Telco Palette.

lcon  Description

Stereotype

CIT CIT UML class that represents a Cl Type

CIT_ATTRIBUTE TR UML class that represents a Cl Type Attribute
ATTRIBUTE_OVERRIDE I UML class that represents a Cl Type Attribute Override
CMDB_RELATION & UML class that represents a Relationship between 2 Ci

Types.

CALCULATED_LINKS_TRIPLET UML class that represents a Calculated Link triplet

between 2 Cl Types

Generalization e UML inheritance link that creates extend value

BR_DASH BR UML class that represents a BR dedicated for BSM
Service Health

BR_SLM BR  UMLclass that represents a BR dedicated for BSM SLM

BR_TOOLTIP_PARAMETER ; UML class that represents a BR tooltip parameter

HI_DASH HI UML class that represents a HI dedicated for BSM
Service Health

HI_SLM Hi UML class that represents a HI dedicated for BSM SLM

HI_ASSIGNMENT_DASH aHL UML class that represents a HI Assignment dedicated
for BSM Service Health

HI_ASSIGNMENT_SLM "s UML class that represents a HI Assignment dedicated
for BSM SLM

HI_CONFIGURATION AL UML class that represents a HI configuration
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KPI_DASH

KPI_SLM

KPI UML class that represents a KPI dedicated for BSM

Service Health

KPI UML class that represents a KPI dedicated for BSM SLM

The following sections discuss the usage of the Telco Palette and what is required to start
working with the palette.

2.1.1 Enabling the Telecom Universe Profile
In order for the Telco Palette to display in Together, the Telecom Universe Profile plug-in
must be installed and enabled in your Together UML project. Once you install the
Borland Together 2008 application that is provided with the Service Designer Installation
Kit, the Telecom Universe Profile plug-in will be installed automatically. Once installed,
you will be required to enable the profile in order to view the Telco Palette in your UML
modelling project. To enable the Telecom Universe profile, you will be required to

perform the following steps:

1.

& Modeling - Eclipse SDK

%Ed\t Source Refactor Mavigate Search Project Model Run Diagram  Window Help
[ = |3 -0-Q- &~ [0l Gr0- [ | Modeling &3 Java
B

From the Start menu browse and select the program option to launch
Borland Together 2008. The Modelling-Together window displays.
Make sure that the Together Perspective is set to Data Modelling. You can

set Perspective by clicking =] [Open Perspective] on the top-right corner of
the Together main window, and then selecting Data Modelling from the pop-

up menu, as shown in the figure below:

Slimodel 5L % Naviga| — O
=
3

i [EER=N=R-0

)

] Properties 2 [} Model aunhnam) (1.3 ¥ =0

Properties ;g, Mobile Services selected

Propert | value
nare B Mobile Services

metaclass & Model

3. Select File > New > Project. The New Project — Select a wizard dialog

displays.
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& New Project H=] E3
Select a wizard
Create a UML 2.0 Project

Wizards:

Itype filker kext

- Madeling -]
ﬁ_,& BPMM from Together 2006 Business Process Project
ﬁ_ﬁ Business Process Modeling Project

----- L C+ Modeling Praject

-3 | Data Modeling Project

----- ?3 10L Modeling Project

DHH Java Modeling Praject

""ﬁiﬂ Java Modeling projects from Java projects

(5% MDA Transformation Project

Pattern Definition

Profile Definition Project

% UL 1.4 Project

X

Z0
F-(22 Plin-in Develnnmanl =l
™ Shiow 8l wizards,

@:l = Back I Mext = I Finish Cancel

4. Select Modelling > UML 2.0 Project from the Wizards list and the click
[Next]. The New Project — Modelling Project dialog displays.

& New Project [_ (O] x|

Modeling Project

Create a new Modeling project f

Praoject name: I Mabile Services|

¥ Use default lacation

Location; IC:'l,data'l,SMF 3.0-WSi\Mobile Services Browse. .. |

‘Working sets

[™ add project to warking sets

Warking sets: j Select... |

@j = Back. MNext = {g Finish I Cancel

5. Enter the Project name and then click [Next]. The New Project — Modelling
Settings dialog displays.

6. Click [Next]. The New Project — Profiles dialog displays. Select Telecom
Universe Profile from the Available profiles list.
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& New Project M=l

Profiles —

Select profiles for the project

Available profiles:

O Business Modeling

O ER Lagical Diagram Profile

O software Development Processes
O standard EJE Prafile

O standard EJ8 Profile {ver. 2.1}
Telecom Universe Profile

O Together UML in Calor Prafile

O weblLogic EJB Extension Profile

Select &l |
Deselect &l |
Set Defaulks |

Frofile description:

Lt

@j < Back Mexk = | Cancel |

7. Click [Finish] to create a new UML modelling project. The newly created

UML project workspace displays.

& Modeling - Mobile Services - Eclipse SDK

File Edt Source Refactor Mavigste Search FProjsct Model Run Diagram Window Help

Jri- JBI$-0-Q- |5 k- -

ﬁ @Modehng 3‘,’ lava

Q2 Model 32 - Nawga] = O || g Mabile Services 32
=

=4

o BEEE q

L7 Palette

&)
;
=
S
g

O-Rte | T~ 5 5
|>.[. Qi R RN R SRR I

B IR

- e PR o %

BUERE]

Ze el e

@
@ m

G Class Diagram Elements
B L % 2 & -
o L B S
g S T
= DL elements _
%

= Template Elements
=

= Motes N
o -
} TELCO Service Designer Palette

A

KP1 < HI

TR

ATTR
oD

HI
Ass

HI
< Canf

K1 CIT

2

A

ER ?
e
1]

]

;le

|

ol

[ Properties 53

Properties % Mobile Services selected

!@ Moded Eookmarls]

i"ﬁlaz - A

Froperk;

| walue

name
metaclass

B Mobile Services
& Model

[N

8. The Telco Service Designer Palette is available in the Palette pane of Borland

Together, as shown in the above figure.
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2.2 Importing SMF UML workspace

In order to facilitate a new Service Model based on current SMF 3.0, an UML workspace
1s delivered.

I Create a folder for your workspace
II.  Start SQM SD using this new workspace
M. Create a new UML 2.0 project like “MyModel”:
e From the Menu, Select “File” > “New” > “Project”
e Onthe “New Project” Wizard, locate “Modelling” folder, and expand it
e Select UML 2.0 project (see screenshot below), and click <Next>
e Enter a project name, and click <Finish>

v Do not use space (““) character in your project name.

V. Use Import -> General -> File System
e Select your project, Right Click
e Select “Import”, in Import dialog select General and then File System
e Click <Next>, enter full path of predefined UML project

Default path is “<SD_1Install_Dir>\SD_Project \ SMF3’, like “C:\Program
Files\HP\SQM\Service_Designer\SD_Project\SMF3”.

e Click [Select All] and then click [Finish]

SaModel 2 % Naviga| = O
<> |BEEsE
a % MyModel
4 [& Service Models
- [# BDMPackage
- [ SQM_SMF_DigitalTV
- [ SQM_SMF_SID
- [ SOM_SMF_SQM
» [ SQM_SMF_TeMIP
4 (8 7 Service Model

V. Recommendation: Set the Borland Together Filter to the following:
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« Model Navigator Filters = XS

Hide:

[ ] Anprivate e
C++ Referenced Libraries
[ ] Closed Projects

Default Package Diagrams
D Design Entities %
D Imported projects

D Java Referenced Libraries
Metamodels
Non-modeling Projects
Non-Together Metamodels

Patterns L

m

2.3 Creating a Service Model

The Telco Service Designer Palette allows you to create a UML model in Together that
can be converted and imported in BSM/RTSM. The following components of a service
model can be defined in Together:

e CI Type

e CIT Attribute & CIT Attribute Override

e CMDB Relationships & Calculated Triplet Links

All the above components are represented as UML stereotypes in the Telco Palette.
Supported Service Models are mapped to BSM Models(refer to Appendix
A). More information could be found in the current BSM.

Any Service Model is contained in a specific package while exported from
, BSM. It is a pre-defined requirement for creating Model that service
“ model(s) be contained in its package. This package name will be used
later as Service Designer command line tool’s parameter.

More information about how to user Service Designer Command Tool,
refer to Translating a UML Model.

2.3.1 Defining a Cl Type

To define a CI Type as a UML class in Together using the Telco Palette, you will be
required to perform the following steps. The following description contains information
only about the required properties when defining a CIT object:

1. On your working package, from the Telco Service Designer Palette, select
the CIT stereotype and then draw the object in the empty workspace

2. Enter the Name of your newly created CIT:

: CC(:I-I—”
% CIT Display Label of my CIT

- S N
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Note: Length of CIT “Name” (“Display Label” in BSM) is limited to 50
characters.

3. Select the newly created CI Type object. The Properties pane displays at the
bottom of the main application window. And verify the “name” field:

=l properties &3 . 0 Model Bookmarkﬂ e A =
Properties CIT Display Label of my CIT selected
Telecom Universe Prc Property Value -
Custom name Display Label of my CIT |= |
Description full name & service Models.Z Service%lodel.Display Label of my C...
Hyperlinks stereotype cIr
extends
= imnlameante i

4. To set the extends (define parent CIT from which your newly created CIT
inherit attributes and properties), click on right side of value field

CT Display Label of my CIT selected

Property Value
name Display Label of my CIT
full name 8 Service Models.Z Service Model....
stereotype cIT
extends

Note: This is a standard way to set CIT parent, another way refer to section
Defining an inheritance Relationship.

5. On the pop-up window, you will select its parent CIT, click < Add>> >, and
<OK>

[T Sclect Class for - .
Model Elements Selected Elements

[ Service Models
(& BDMPackage
(@ SQM_SMF_Digital TV
(& SQM_SMF_SID
(& Business
(& Interaction
[# Management
(& Product
(& Resource Add >>

Sy

= ResourcefacingService
tr Customer Facing Service
tm ResourcefacingService
o Service Bundle
tm Service Package

m Business

— ]

»

o) CITService Models.SQM_SMF_SID.Service ResourceFacingService

m Interaction
Or Management
&m Product

m Resource

LT Sarvira

OK [ H Cancel

6. To obtain this in “extends” field:

CIT Display Label of my CIT selected

Property Value =l
name Display Label of my CIT |E|
full name & Service Models.Z Service Model.Display Label of my CIT i
stereotype CIT
extends Service Models.SQM_SMF_SID.Service.ResourceFacingService

imnlamante

Note: make sure you do have only one CIT as value.
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7. From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below.

=l Properties 2 . I Model Bookmarks

CT Audio Data selected

Properties

Telecom Universe Profile Property Value
Custom Icon Name

Description Identifier

Hyperlinks Label Format

Vi Qualifiers

8. There are four properties, but only one is mandatory: Identifier

e Mandatory: Enter an Identifier for the new CI Type. This CIT
property is required in BSM.

Note: Length of CIT “Identifier” ("Name” in BSM) is limited to 30
characters, and only use character a-z, A-Z, 0-9 and “_ “..

¢ Optional: Enter an Icon Name for the new CI Type.

Note: if you do not set an icon, it will inherit from the parent CIT.

e Optional: Enter a Label Format for the new CI Type.

You build a label by selecting attributes in the CI Type Attributes
pane and adding them to the Format pane, using the operators in
the Format pane to connect them.

The label appears as the title under a CI of the new CI Type. The
label definition can be customized to include different attribute
values. For example, if the function label of the node CIT is
composed of hostname and network, the displayed label is:
serverl 10.0.65.0.

Labels can also be created using regular expressions.

Note: check BSM documentation about “Qualifier Tab” to get more

Information (System Administration > Modelling > Modelling > CI Type
Manager > Create Configuration Item Type/Relationship/Calculated

Relationship Wizard > Default Label Page).

e Optional: Enter a Qualifier for the new CI Type.

Note: check BSM documentation about “Qualifier Tab” to get more

information (System Administration) > Modelling > Introduction to RTSM
> Topology Query Language > Query Node/Relationship Properties Dialog

Box).

9. Finally, you could enter a description:
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=l Properties £2 . 2l Model Bookmarks =&~ =08

Properties CIT Display Label of my CIT selected

Telecom Universe Profile %8BI us|Bl=s==s€s i |EEn|@Y EF

CISET This 15 the place holder to enter a description of you newly created CTT i
Description

Hyperlinks [

View

WYSIWYG | Source View‘ edit-an® JavaBean SDK by RealObjacts

Note: Length of CIT “Description” is limited to 500 characters.

2.3.2 Defining a CIT Attribute

To define attributes of an existing CI type, in Together, using the Telco Palette, you will
be required to perform the following steps. The following description contains information
only about the required properties when defining CIT attributes:

1. On your working package, from the Telco Service Designer Palette, select
the CIT_ATTRIBUTE stereotype and then click inside the CIT object that
already exists in the workspace.

2. Enter the Name of your newly created CIT_ATTRIBUTE:

“Cl-l—”
CIT Display Label of my CIT

lme My Attribute Display Label
Note: Length of CIT_Attribute “Name” (“Display Label” in BSM) is limited
to 100 characters.

3. In the Properties Pane, set different properties:

1. Mandatory: select the data type:

£l Properties & . Jl Model Bookmarks

Properties imis My Attribute Display Label selected
Telecom Universe Profile Property Value
Custom type Integer
Description default value
Hyperlinks name

- full name
View

stereotype

1. Optional: set a default Value

4. In the Telecom Universe Profile tab, set other properties for the CIT
attribute:
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£ Properties & . 2 Model Bookmarks

Properties wme My Attribute Display Label selected
Telecom Universe Profile Property Value
Custom Asset Data I false
Description Change Monitored I false
Hyperlinks Comparable I false
N Enable Auto Truncate by DDM I false
View
Identifier Myidentifier
Index I false
Key I false
Lower Case I false
Password I false
Required I false
Size
Upper Case I false
Visible I false
1. Mandatory: enter a new unique identifier:
Note: Length of CIT_Attribute “Identifier” (‘Name” in BSM) is
limited to 100 characters, and do not use “ “ (space) character.
ii. Optional: set the attribute size in case of String.
1ii. Optional: change some Boolean attribute if needed:

5. In the Description tab, you could enter a description for this CIT attribute.
Note: Length of CIT “Description” is limited to 100 characters.

2.3.3 Defining a Relationship

A relationship defines the link between two Cls. Relationships represent the
dependencies and connections between the entities in your I'T/TELCO environment. On
the BSM RTSM Administration UI, When you select relationships or calculated
relationships in drop-down box in the CI Types pane, the topology map displays all the
valid instances of CITs linked by the selected relationship.

In UML model, a relationship is represented as “Kernel Association”

(“CMDB_RELATION"):
«CMDB_RELATION:» ‘ Imp'e}‘éﬁﬂ/
“cl-r”

«CIT>» Requires 1 1 + +
CIT Customer Facing Service CIT ResourceFacingService
+
b
Tl ”
Comprised Of

«CMDB_RELATION=

To define a relationship between two objects in a UML model using the Telco Palette, you
will be required to perform the following steps:

1. From the Telco Service Designer Palette, select the CMDB_RELATION
stereotype.

2. Draw the relationship from the child object to the parent object, such as
shown in the figure below.
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| «CMDB_RELATION>
«CIT» R e T EE ' «CIT»

1101
CIT Audio Data O CIT Audio Stream

N

3. Select the newly created relationship. The Properties pane displays at the
bottom of the main application window.

4. Enter a label name for the new relationship, which will be converted to the
display name of the CI relationship in BSM.

5. From the Properties pane, select Telecom Universe Profile tab, as shown

in the figure below.

Cl Properties &2 2l Model Bookmarks

[Contain: [Audio Stream] -> [Audio Data]] selected

Properties

Client Property Value

Supplier Identifier sgm_link_contain
Telecom Universe Profile Qualifier

6. Enter an Identifier for the relationship. This property is required in BSM.
Please ensure that the identifier matches the corresponding BSM relationship
name (case-sensitive, no space (“ ), and no dash (“-“)).

2.3.4 Defining an inheritance Relationship

You define an inheritance relationship when you want a CIT that inherit the attributes
and behaviour (such as the label function) of the parent CIT. There is already one way to
create inheritance relationship in section Defining a CI Type. Here is another way.

1. Select from the Class Diagram Elements palette.

2. Click the child CIT, there will be a line attached to mouse cursor. Move mouse
to parent CIT and click again.

«CIT»
CIT Parent CIT

«CIT»

CIT Display Label of my CIT

3. The inheritance relationship is created between the two CI types, as shown in
the figure below.

«CIT»
CIT Parent CIT

«Generalization=

«CIT»
CIT Display Label of my CIT
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2.3.5 Defining a Calculated Link triplet

SMF 3.0 is providing RTSM relationship and Calculated Links Triplet for the SID
domains, so any TELCO CIT will inherit from them. But you might need to have KPI
propagation between IT and TELCO CIT’s; in this case, you will have to create a new
Calculated Links Triplet by performing the following steps:

1.

From the Telco Service Designer Palette, select the
CALCULATED_LINK_TRIPLET stereotype.

Draw the relationship from the child object to the parent object, such as
shown in the figure below.

I I
1 Contain 1
«C[T» «CIT=

CIT Audio Data RN CIT Audio Stream

H

Select the newly created relationship. The Properties pane displays at the
bottom of the main application window.

Enter a label name for the new relationship, which will be converted to the
display name of the CI relationship in BSM, and modify the name.

From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below

[Kernel Association: [Audio Stream] -> [Aw

Property Value
CalculatedLinkType impact_dependency
Identifier sqm_link_contain
[sForward ¥ true

Enter an Identifier of the relationship. This property is required in BSM.
Please ensure that the identifier matches the corresponding BSM relationship
name (case-sensitive, no space (““), and no dash (“-“)).

Enter the CalculatedLinkTriplet (value should be
“impact_dependency”)

Check “isForward” if the relationship direction is from “source” to “target”
(default is false: it means the impact is from “target” to “source”): uncheck
false to have set it to true.

2.3.6 Creating a link for Existing CIT

It is possible there are several packages, and in each package there are several CITs
inheritance from the same CIT, you should not create the parent CIT in all the packages.
In this situation, you will need to create CIT link by performing the following steps:
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1. Suppose there are existing packages as shown below. From the view pane,
select your package and open the view.
«CIT=
CIT Parent CIT 1
«Generalization»
a(CIT=
CIT Display Label of my CIT
packagel package2 package3
«(C[T= «CIT»
T Display Label of my CIT2 || | GIT Display Label of my CIT3
2. Right click, select “New”, and select “Shortcut”.
New Insert» Activity Diagram Elements 4
New Diagram » Class Diagram Elements »
Select in Model Tree Component Diagram Elements »
Select Metaclass In Model Tree Composite Structure Diagram Elements 4
Select in Project v Deployment Diagram Elements 4
Open Interaction Diagram Elements 4
i OpenIn Active Editor State Machine Diagram Elements 4
CTDisplay Label of my €IT2 | | o+ cut Use Case Diagram Elements ,
Copy Telecom Universe Profile 4
Paste [# Package
Paste element Ctrl+Shift+V [0 Class
Delete ‘& Interface
Delete with contents %  Enumeration
Data Type
n‘_;n ernp::tt... Yo Association Class
SIS [F Instance Specification
Compare With Y| ¥ Constraint
Model Bookmarks *| [ Note
Team " shertcut.. Ctrl+Shift+N
(R N P Feel Chife L |
3. After “Shortcuts” windows shows, select parent class on the left and click

<ADD>>>, then click <OK>.

& Shortcuts...

-

Model Elements

4 [ Services Models
» L packagel
» L& package2
- [# package3

»|%em Parent CIT
g Services Models
» g Test
» @ metamodels
» @ patterns
> @ PrimitiveTypes

> o Display Label of my CIT

Selected

CITServices Models.Parent CIT

Add ==

<< Remove All

[ OK Cancel

)|

4. A CIT Link shows in the view as below. Then you can add inheritance
between the two CITs.
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«(CIT=
CIT Services Models.Parent CIT

«(CIT=
CIT Display Label of my CIT2

5. Here is an overview of the view.

<CIT>
| = «Generalization»
<CIT»
CIT Display Label of my CIT
packagel package2 package3
«CIT»
I} CIT Display Label of my CIT3
«C[T»
CIT Display Label of my CIT2

Link and real CIT models are referenced to each other, so you can delete
N the link but you cannot delete real CIT model.

s Link cannot be copy/cloned due to modeling tool functionality. If you
need mutiply links, you need to perform all the steps in each package.

2.4 Creating a Content Pack

The Telco Service Designer Palette allows you to create a UML model in Together that
can be converted and imported in BSM/Service Health and BSM/SLM repositories. The
following components of a service model can be defined in Together:

e Business Rules

e Health Indicators

e KPIs

Transducer checks the references between BR, HI, KPI and so on. So

if using existing BSM Rule, it is strongly recommended that import
all BSM, SQM BR before creating any HI/KPI.

All the above components are represented as UML stereotypes in the Telco Palette.
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2.4.1 Defining a Business Rule

To define Business Rule in a UML model using the Telco Palette, you will be required to
perform the following steps:

1.

From the Telco Service Designer Palette, select the BR_DASH or
BR_SLM stereotype. Your choice should depend on whether you want to
define a Dashboard Business Rule or SLM Business Rule.

Draw the object into a specific package of the workspace.
Any Service Model is contained in a specific package while exported from

BSM. It is a pre-defined requirement for creating Model that service
model(s) be contained in its package. This package name will be used

4 later as Service Designer command line tool’s parameter.

More information about how to user Service Designer Command Tool,
refer to Translating a UML Model.

Select the newly created Business Rule object. The Properties pane displays
at the bottom of the main application window.

TR basky

Enter a name of the Business Rule in the name text field. The name will be
mapped in BSM.

It is recommended to follow this naming convention to have unique

name within BSM:
BR-<Name of the Business Rule>-(Service Health|SLM)

Example: BR-My Rule(Service Health)

Select the newly created BR object. The Properties pane displays at the
bottom of the main application window, and Verify the name:

£ Properties &2 . J] Model Bookmarks
BR my DASH BR selected

Properties
Telecom Universe Profile Property Value
Custom name my DASH BR|
Description full name & Service Models.Z Service Model.BR.my DASH BR
Hyperlinks stereotype BR_DASH
- extends
View i
implements
visibility public [

If the scope of BR is “Service Health” and “SLM”, then select “stereotype”
value, and on the right side click B

On the pop-up window, click <Add>

Use the drop down menu, to select “BR_SLM?”, and click <OK>
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« Edit Property Values % |

BR_DASH
BR_SLM v

HL_SLM
KPLASSIGNMENT_DASH
cIr

4 |n

HILASSIGNMENT_SLM

6. From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below.

=l Properties &2 . il Model Bookmarks
BR my DASH BR selected

Properties
Telecom Universe Profile Property Value
Custom DASH_ApplicableCITypes
Description DASH_Domain
Hyperlinks DASH _Identifier
- DASH_Java Class
View

DASH_RuleParameters
DASH_RuleType
DASH_Units
DisplayName
SLM_ApplicableCITypes
SLM_Domain
SLM_Identifier
SLM_Java Class
SLM_RuleParameters
SLM_RuleType
SLM_Units

7. Mandatory parameters:
(1) DisplayName: The name will be mapped in BSM display label.

(2) DASH_ApplicableCITypes /SLM_ApplicableCITypes: CIT that could
use this BR.

Example:

sid_business_interaction,monitor, location,sid_product, sid_resource,
sid_management_domain, sid_service,party,
sid_business_interaction_item.

(3) Do not set identifier DASH_Identifier / SLM_Identifier).

Do not set the Identifier. BSM will create one when you load
the Content Pack.

Best Practice is to re-import those newly created BRs into SQM
SD after

Importing CP in BSM
Exporting CP of BSM
Using the reverse Transducer.
(4) Enter the location of the Java class that defines the Business Rule, in the

DASH_dJavaClass (or SLM_dJavaClass) text field. This property will be
mapped in BSM.
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Example: com.hp.sqmbsm.businessrules.dashboard.generic.TestRule

(5) Click 7. on the right side of value field, to select the type of the Business
Rule, in the DASH_RuleType (or SLM_RuleType) text field. This
property will be mapped in BSM.

DASH_RuleType
DASH_Units Health Indicator T

DisplayMame K_PI_
SLM AoplicableCITvpes ~ 2iRling

8. Optional parameters:
(1) DASH_Domain/SLM_Domain: SQM uses “telecom”.
(2) DASH_RuleParameters/SLM_RuleParameters: To add BR

parameters click Q On pop-up window click <Add>, and enter
parameter with mandatory fields:

»  Defaultvalue
= Description
= Mandatory

= Name
= Type
» isParamNameReadOnly
= Hidden
Example:

defaultvalue="" description="HI Type as defined in the repository"
mandatory="" name="HI2" type="String" isParamNameReadOnly="false"
hidden="false"

For more information about the mapping between CMDB properties and
a UML properties of different model components, refer to Appendix A.

) For more information about different properties of the BSM components
discussed above such as Group Rule, Qualifiers, Label Format etc., refer
to the relevant BSM documentation.

2.4.1.1 Defining a Business Rule Tool Tip Parameter

To define Business Rule Tooltip parameter in a UML model using the Telco Palette, you
will be required to perform the following steps:

1. From the Telco Service Designer Palette, select the
BR_TOOLTIP_PARAM stereotype.

2. Draw the object in the Business Rule.

«BR_DASH,BR_SLM»
BR my BR TEST

\=8-BR_TOOLTIP_PARAM1:Integer(1]

3. Enter a parameter name and type in the Properties tab:
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= Properties &3 . ] Model Buokmarks]

Properties O Business Rule selected

Telecom Universe Profile Property Value

Custom type

Description default value

Hyperlinks name Business Rule

View full name B Service Models.Z Service Model.BR.my BR TEST.Business Rule
stereotype BR_TOOLTIP_PARAM

4. Enter the mandatory “formattingMethod” and “ValueSource” fields in the

Telecom Universe Profile tab:

£ Properties &2 . 8 Model Bookmarks|

Properties £ Business Rule selected

Telecom Universe Profile Property Value

Custom ForamttingMethod rulelDtoString
Description ValuePostfix

Hyperlinks ValuePrefix

View ValueSource NODE.DIM.RULE.ID_CUST

2.4.2 Defining an Health Indicator

To define HI in a UML model using the Telco Palette, you will be required to perform the
following steps:

1.

5.

6.

Select the HI_DASH or HI_SLM stereotype. Your choice should depend on
whether you want to define a Dashboard or SLM HI.

Draw the object in the workspace.

«HL DASH:= I

GHI DASHL
(|

Enter a name (BSM “Display Label”):
| «HIDASH»
# HI My Test HISH "

or = ]

Select the newly created HI object. The Properties pane displays at the
bottom of the main application window, and Verify the name:

=l Properties 22 . il Model Bookmarlcq
|
IProperTies HI My TEST HI selected
Telecom Universe Profile Property Value
Custom name My TEST HI
Description full name & Service Models.Z Service Model HLMy TEST HI
Hyperlinks D 1E HLDASH
- extends

View N

implements

visibility public

If the scope of HI is “Service Health” and “SLM”, then select “stereotype”
value, and on the right side click Q
On the pop-up window, click <Add>
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« Edit Property Values léy

HI_DASH

I oK ] I Cancel ]

7. Use the drop down menu, to select “HI_SLM”, and click <OK>

« Edit Property Values Py

HI_DASH
HLSLM

HILASSIGNMENT_DASH
HLASSIGNMENT_SLM
implementationClass

type

1

8. From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below.
=l Properties &2 . il Model Bookmarks
HI My TEST HI selected

Properties

Telecom Universe Profile Property Wl
Custom CIT

Description DASH_DefaultRule

Hyperlinks DASH_FormattingMethod

View DisplayName

Identifier
SLM_DefaultRule
Units

Note: Identifier Value will be generated by transducer.

Note: In case of “Service Health” HI, SLM_DefaultRule is not present.
9. Mandatory:

(1) CIT: BSM Name of CIT on which HI is attached.

(2) DisplayName: BSM Name of HI

10. Mandatory (DASH):
(1) DASH_DefaultRule: the BSM Service Health Rule that does apply on
this HI (Rule Type = “Health Indicator”).
use the field “Property > Name” of your BR.
Value is following this naming convention:
BR-<Name of the Business Rule>-(Service Health|SLM)
Example: BR-API Simplified Average Rule(SLM)

Note: please refer to BSM doc for more information : Applications > Using
Service Health > Repositories > Business Rule Repository > List of
Calculation Rules in Service Health
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(2) DASH_FormattingMethod: enter the BSM Formatting Method.

For Example:

analyzeSiteScopeMessage
encoce
farmatDateTime
farmatDecimalNumber
formatPnr'yalue
getHHMMSS
getint'alue -

Note: please refer to BSM doc for more information : Applications > Using
Service Health > Repositories > KPI Repository > New KPI/Edit KPI
Dialog Box > List of Formatting Methods

11. Mandatory (SLM):

(1) SLM_DefaultRule: enter the BSM SLM Rule that does apply on HI
(Rule Type = “Health Indicator “):

Note: please refer to BSM doc for more information : Applications > Using
Service Level Management > Service Level Management Repositories >

Business Rule Repository > List of Service Level Management Business
Rules

12. Optional: Units: string to represent the HI units
13. Do not set identifier DASH_Identifier / SLM_Identifier).

Do not set the Identifier. BSM will create one when you load
the Content Pack.

Best Practice is to re-import those newly created HIs into SQM

SD after
v Importing CP in BSM
Exporting CP of BSM

Using the reverse Transducer.

2.4.3 Defining a Key Performance Indicator

To define KPI in a UML model using the Telco Palette, you will be required to perform
the following steps:

1. From the Telco Service Designer Palette, select the KPI_DASH or
KPI_SLM stereotype. Your choice should depend on whether you want to
define a Dashboard KPI or SLM KPI.

2. Draw the object in the workspace, and enter your new KPI name
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3. Select the newly created KPI object. The Properties pane displays at the
bottom of the main application window.

Pl

= - = or

4. Verify the KPI name in the name text field. The name will be mapped in
BSM.

£l Properties i3 . ] Model Bookmarks]
|

[Properties kPl My SH KPI selected
Telecom Universe Profile Property Value
Custom name My SH KPI
Description full name & Service Models.Z Service Model.KPLMy SH KPI
Hyperlinks stereotype KPLDASH

- extends
View B

implements

5. From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below.

£ Properties & . Model Book.marks]
Properties K1 my SH KPI (Service Health) selected
[Telecom Universe Profile Property Value
Custom DASH_ApplicableRules BR-Generic Groovy Group And Sibling Rule(Service Health), |
Description DASH_Domain Telecom
Hyperlinks DASH_GroupRuleName BR-Worst Child Rule(Service Health)
DASH_Identifier
DASH_UserRole Both
DisplayName my_SH_KPI

6. Enter a list of Applicable Rules: ApplicableRules,

use the field “Property > Name” of your BR.
Name is following this naming convention:
BR-<Name of the Business Rule>-(Service Health|SLM)
Example: BR-API Simplified Average Rule(SLM)
Note: You could view the list of Calculation Rules in Service Health in

Applications > Using Service Health > Repositories > Business Rule
Repository > List of Calculation Rules in Service Health

7. Enter a Domain: for Example Telecom

8. Enter a default Group Rule Name from the list defined above:
GroupRuleName,

9. Select User Role: UserRole (Both, Business, Operation)
10. Do not set identifier DASH_Identifier / SLM_Identifier).

Do not set the Identifier. BSM will create one when you load
the Content Pack.

Best Practice is to re-import those newly created KPIs into SQM
SD after

Importing CP in BSM
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Exporting CP of BSM

Using the reverse Transducer.

2.4.4 Defining an HI Assignment

To define HI Assignment in a UML model using the Telco Palette, you will be required to
perform the following steps:

1.

8.

9.

From the Telco Service Designer Palette, select the
HI_ASSIGNMENT_DASH or HI_ASSIGNMENT _SLM stereotype. Your
choice should depend on whether you want to define a Dashboard or SLM HI
Assignment.

Draw the object in the workspace, and enter your new HI Assignment name
«HLASSIGNMENT_DASH» |!
* 8l my_HI ASSIGNMENT TEST|

Select the newly created HI_Assignment object. The Properties pane
displays at the bottom of the main application window.

Verify the HI_Assignment name in the name text field. The name will be
mapped in BSM.

From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below.

[l Properties i [l Model Bookmarks

Properties AL my_HI_ASSIGNMENT_TEST selected
Telecom Universe Profile Property Value
Custom DASH_CIT
Description DASH_CIT_Equals_Value
Hyperlinks DASH_Identifier
. DASH_MonitoredBy
View - N
DisplayMame

Enter a CIT, DASH_CIT or SLM_CIT, to which the HI Assignment apply

Optional: Enter CIT Equals Value, DASH_CIT _Equals_Value or
SLM_CIT_Equals_Value

In HI assignment definition, there will be two kinds of conditions

o  <condition cmdb-class="temip_managed_object" includeDerivedClasses="true"
monitored-by="SQM">
<property-condition name="root_class" operator="EQ"
value="temip_managed_object"/>
</condition>

o  <condition cmdb-class="temip_service_console" includeDerivedClasses="true"
monitored-by="SQM"/>

Set the MonitoredBy to SQM
Enter a Display Name: DisplayName

10. For every HI, define an HI Configuration
11. Do not set identifier DASH_Identifier / SLM_Identifier).
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Do not set the Identifier. BSM will create one when you load
the Content Pack.

Best Practice is to re-import those newly created HI
Assignments into SQM SD after

Importing CP in BSM
Exporting CP of BSM

Using the reverse Transducer.

2.4.4.1 Defining an HI Configuration

For every HI, you need to assign to your CI Type, you need to define an HI Configuration
within HI assignment.

1. From the Telco Service Designer Palette, select the
HI_CONFIGURATION stereotype.

2. Draw the object in the workspace, and enter your new HI Configuration name

«HLASSIGNMENT_DASH=» N
AHLSQM_HI_ASSIGNMEN...

c_uHr +HI_ CONFIGURATIONI:Integer[1]

Note: you could keep the default or enter a meaning full name with your HI.
Name just has to be unique within the HI Assignment.

3. Select the newly created HI_Configuration object. The Properties pane
displays at the bottom of the main application window.

4. Verify the HI_Configuration name in the name text field. The name will be
mapped in BSM.

5. From the Properties pane, select Telecom Universe Profile tab, as shown
in the figure below.

=l Properties &2 [l Model Bookmarks

Properties L HI_CONFIGURATION1 selected

Telecom Universe Profile Property Value

Custom HIName My Test HI SH

Description Priority 0

Hyperlinks RuleName BR-Generic Sample Rule(Service Health)
View RuleParameters formattingMethod="NO_FORMATTING_M

TrinitySelector
Set the HI Name, HIName (from field of your HI: Property > Name)
Set a priority (default is 0)

Set the Rule Name, RuleName, used to retrieve HI value.

© ® 2>

Set the Rule Parameters, RuleParameters. They depend of Rule Name.

For example on “Generic Sample Rule”, set

formattingMethod="NO_FORMATTING_METHOD" key="Time Stamp Field" type="5String" value="time_stamp”
formattingMethod="NO_FORMATTING_METHOD" key="Field Name" type="5tring" value="dValue"
formattingMethod="NO_FORMATTING_METHOD" key="No data timeout” type="Long" value="900"
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Note: You could view the list of Calculation Rules and their parameters in
Service Health in Applications > Using Service Health > Repositories >
Business Rule Repository > List of Calculation Rules in Service Health

10. Set the Selector, TrinitySelector, to find right CI.

For example if BSM exported CP file using eti_id and szTagertName, it could
be:

<CompositeSelector logicalOp="OR">

<CompositeSelector logicalOp="AND">

<Selector key="eti_id" op="EQ" type="Binary" value="60444f48d145487d8f172¢927d61b4{8"/>
<Selector key="szTargetName" op="EQ" type="String" value="{RefProp:sid_object_identifier}"/>

—n

<Selector key="sampleType" op="EQ" type="String" value="ss_t"/>
</CompositeSelector>

</CompositeSelector>Then we set values in Together Trinity Selector with three
rows like this:
key="eti_id" op="EQ" type="Binary" value="60444f48d145487d8f172e927d61b4f8"

key="szTargetName" op="EQ" type="String" value="{RefProp:sid_object_identifier}"
key="sampleType" op="EQ" type="String" value="ss_t"

Trinity Selector could not be able to run after imprted into BSM,
you might need to do a manually setup after the import to makr
sure it works.

Page 35/59


http://plotin.gre.hp.com/topaz/amdocs/eng/doc_lib/Service_Health/dashboard_welcome.html
http://plotin.gre.hp.com/topaz/amdocs/eng/doc_lib/Service_Health/Book_24_1.html
http://plotin.gre.hp.com/topaz/amdocs/eng/doc_lib/Service_Health/rule_repo_ref.html

Chapter 3

Deploying
Service Models in BSM

This chapter discusses the procedures involved in exporting UML models and converting

these models to a BSM/RTSM-recognized service model and then importing them in
BSM.

3.1 Exporting a UML Model

To export a UML model from Together, you will be required to perform the following
steps:

Launch the Together application from the directory where it is installed
Open the project containing the UML model that you want to export
Select File & Export... to export the UML model

- W o

The Export window displays

& Export = | B ||

Select

A
Export Model to XMI File E 5 l

Select an export destination:

type filter text

(= General
(= Java
= Modeling [
@] BPEL4WS File
- DDL/SQL script
‘@ Documentation Using Template
E_?;J Generate C++ Project
C[}J Generate Java Project
@] Image (GIF, JPEG, Bitmap, EMF, 5VG)
E‘f‘ Pattern conversion profiles
[‘f‘ Pattern definition
nﬁ,, Profile Plug-ins
|pei UML 2 Tools
ZZ XMIFile
= Plug-in Development
= Run/Debug
(= Team |
(= XML

5. Select XMI File from the Select an export destination list and then click
[Next]. The XMI Export window displays
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& XMl Export S5

Export Project to XMl File

Select Type of Model's Export to XMI File

=
2% Mobile Services

Select XMI Type:
XMIfor UML 1.3 (Unisys Extension)
XMIfor UML 1.3 (Unisys Extension, Recommended for TCC)

¥MI for UML 1.3 (Unisys Extension, Recommended for Rose)
¥MIfor UML 1.4 (OMG)

XMIfor UML 2.0

HMIfor UML 2.0 compliant with OMG standard

KMIfor UML 2.1

KM Version: 20

XMI Encoding: | UTF-

Select the export destination.
XMIfile | \Borland\Together\workspace\Mobile Services\out\xmi\Mobile Servicesl [l + | Browse...

Options

Use prefix of imported root

6. Select XMI for UML 2.0 from the Select XMI Type list
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7. In the Select the export destination: XMI file text field, rename the
extension of the output file from UMLZ2 to XMI, as shown in the figure below
& XMI Expart =HACE X"
Export Project to XMI File 3
Select Type of Model's Export to XMI File ‘G»
1% Mobile Services
i
|
L
Select XMI Type:
AMI for UML 1.3 (Unisys Extension)
AMI for UML 1.3 (Unisys Extension, Recommended for TCC) l
XM for UML 1.3 {(Unisys Extension, Recommended for Rose) I
AMI for UML 1.4 (OMG)
@ XMI for UML 2.0
() XM for UML 2.0 compliant with OMG standard
() XMI for UML 2.1
KMI Version: 20
Select the export destination.
*MIfile  CA\Borland\Together\werkspace\Mebile Services\outxmi\Mebile ServicestEI + | Browse...
Options
Use prefix of imported root
® [ <Beck J[ mea> || i
8. You can also change the destination path of the output .XMI file. Click
[Finish] to complete the export procedure.
9. The UML model will be exported as an .XMI file to the selected destination

folder.

3.2 Translating a UML Model

Once you have exported the UML model as an .XMI file, it can now be converted to a
BSM/RTSM-recognized package and/or Content Pack. It is recommended to use the UML
Package option in order to focus on a specific domain model. To translate a UML model
.XMI file, you will be required to perform the following steps:

1.

Launch the Windows Command Prompt from the Start menu and enter the
Service Designer installation directory.

Execute the Transduce.bat command by entering required parameters i.e.
input file path and output folder path. The input path must contain the .XMI
file exported from Together. Use the mandatory -filterpkg option to convert a
specific package in the .XMI file. You should use different UML packages for
CIT/Relationships and KPIs/BRs. The name of the output .ZIP file will be
same as the name of the UML package. An example of Transducer tool
execution is shown in the figure below.
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B Administrator: Command Prompt E@éj

C:“\Program Files“hp:SQM~Service_Designer>Transduce.bat —filterpkg SQM-SMHE c:\mohl’
ileservices~mohile_services.xmi c:\BAC_Model

"¢ :~BAC_Model" n’'t exist. create folder c:\BAC_Model

create folder AC_Model".

Tranzducer end cessfully

A1l the converted result can bhe found at "c:~BAC_Model"

C:~Service_Designer’>_

Transduce.bat Usage:
C:\>Transduce [-options] <Together XMI file> <output folder>
where options include:

-help {print the help text}

-filterpkg <package name> {specify package in XMI file to be
converted}

A message will be displayed confirming the successful conversion of the UML
model file to a BSM/RTSM-recognized package and/or Content Pack.
Depending on the contents of the selected UML package, a .ZIP file will be
generated that contain definitions for CITs and relationships and a . XML file
will be generated that contain definitions for BRs, HIs, and KPIs.

It is not recommended to modify the Telco Universe
< otherwise SMF will not be supported.

3.3 Deploying a Service Model in BSM

Once the UML model is successfully converted to a BSM/RTSM-recognized model, you
can import it in BSM as a service model package. To perform these operations, you will
be required to follow different procedures for deploying CITs and relationships (see ...).

If the UML package contains HI, KPI, BR, a Content Pack XML file will be generated
and you will have to perform other operation to deploy HIs, KPIs, propagation rules and
business rules.

3.3.1 Deploying CITs and Relationships in BSM

To deploy CITs and relationships contained in a service model, in BSM, you will be
required to perform the following steps:

1.

Launch the Business Availability Centre (BSM) application. For information
about launching and logging in to BSM, refer to the BSM documentation

Select Admin 2 Universal CMDB and then click the Settings 2 Package
Manager tab

The Settings > Package Manager window displays
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ss Service Management - RTSM Administration Full Screen View  User: administrator
@ - MyBSM  Applications » Admin + Help v  Site Map

[ Adminisiration > Package Manager |

Modeling Data Flow i 8]
=
View = Tools
F g X RB-4@#lwag W TN
= Package Mame ‘ Category | Readme ‘“ersion Description
l__| Active_Directory Applications Readme 9.0 Active Directory topology discovery e |
1| Atertsmodel
1L AlertsTgs Alerts a0
lJ Alteon_application_switch Network Readme a0 Mortel Afteon Application switch discovery
lJ ApacheTomcat Web Tier a0 Apache Tomecat Web Server Discavery
I_J ApiAdapter 90 Api Adapter - for defining LOA to integrations =
L] assets 90
l__| AtriumPushAdapter Integration Readme 8.0-SHAP Integration allows push of Cls and Relationships from UCMDE to BMC Remecdy/Atrium based on pre-defi...
l__| AutoDiscoveryContent Basic 9.0 AutoDiscoveryContert package contains common library scripts such as modeling.py, configuration file...
l__| AutoDiscoveryinfra Basic 9.0 Contains UWCMDB Auto Discovery Infra basic resources
lJ BAC_perspectives 80
1| BACKPIsAdapter 75
l_J Basic_Business Basic 90 Basic Business Classes %
I_J Basic_Classes Basic 90 Basic UCMDE Classes and Type Definitions ¢
I_J Basic_Security Basic 90 Default Security Configuration of UCMDB (users, roles and permissions)
l__| BasicForMam Basic 9.0 Basic UCMDB Scheduled Jobs and Reports
ILiee
IL| Bsmaerts

4. Click ‘El [Deploy Packages to server (from local disk)]
5. The Deploy Packages to Server dialog displays

6. Click ¥ [Add], browse and select the .ZIP package generated by the
Transduce.bat command-line tool. An example is shown in the following
figure

-
|£| Deploy Packages to Server{from local disk) ﬁ

Look: In: |E Mobile Services |V| @ ®
Eclass

B3 dimensions

E rulermap

E3 valiclinks

| Mobile_Services zip

File Mame: | Mobile_Services zip |

Files of Type: | zip Files * zip [=]

[ Open | Cancel

7. Once you add the .ZIP package, the Deploy Packages to Server dialog displays
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| 4| Deploy Packages to Server [

Choose the package zip files to be deployed
+ ¥

Package (zip) Path
Mobile_Services.zip CABAC_|

Ser _Services.zip

Select the resources you want to deploy

Rl

[“class - Service CI1

[vlclass - Service €I 2

[Vclass - sid_links

[w]validlinics - depends_on.Service Cl 2 Service CI1

T

8. From the Select the resources you want to deploy list, select the
checkbox adjacent to the resources that you want to import into BSM.

Class: represent CI Types
validlinks: represent relationships.

9. Click [OK] to import the selected package resources into BSM/RTSM.

3.3.2 Deploying BRs, His and KPIs in BSM

To deploy HIs, HI assignment, KPIs, KPI assignments, Propagation Rules and Business

Rules contained in a service model, in BSM, you will be required to perform the following
steps:

Launch the Business Service Management (BSM) application. For information
about launching and logging in to BSM, refer to the BSM documentation

2. Select Admin 2 Platform and then click the Content Packs tab

3. The Content Packs Manager window displays

Service Management - Platform Administration
& ~  MyBSM Appleations + Admin v Help v  Site Map

[ Content Packs

Setup and Mai Report Scheduling Locations Eontent Packs Users and Permissions

Contert Pack Defintions Details
S * l 2

() BPI Cortert Pack
[mi} Diagnostics Cortert Pack
[ EUM_BPht
T EUmt_RUM
(T HPopreds
(T HrOprEes
[ HPOprExc
T HPOprin
(0 HrOprJEE
(0 HPOprLys
T HPopriss
(0 HrOprora
(T WS MDS Lak
(T OMi Content Pack
() 0OTE Corterts for Ohi

4. Click icon to import new Content Pack
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5. On the “Import Content Pack” window, select the CP XML file, check

“Create” and “Test”

Mewy BR_and_KPLxml - lmport Cortert Pack

[x]

6.

Cortert Pack File:

| Mewe_BR_and_KP1xmi | “

() Overwrite

Imports all ohjects contained within the cortent pack, including the cortent pack
definition. &ny ohjects exizting in the target system with 1Ds that match objects inthe
specified cortert pack are oververitten. Any newy objects are created. If any IDs do not
match, the entire impaort is cancelled.

(®) Create

Imports all ohjects contained within the content pack, including the content pack
definition, and ignores any objects in the content pack, excluding the content pack
definition, that currertly exist on the target system.

Test

Fun import in test mode only. No changes are committed to the database.

N

[ =) Recuired field

[Cimoort 8 Corcel T e

Click “Import”, and If there is no error

Impart Mew_BR_and_KPlLxml - Result

@ Import of Contert Pack [Mew BR and KPI) was successfully tested. Content not
madified.

Mumber of Business Rule ohjects successfully processed. 4i4.

Mumber of Cortert Pack Definition objects successfully processed: M.

7. Click “OK”, uncheck “Test” , and click “Import”.
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Chapter 4

Importing Service Models
In UML

This chapter discusses the procedures involved in exporting BSM/RTSM service models
and Content Packs, then converting them to a UML model and finally importing them in
Together in a UML package.

4.1 Retrieving a Service Model

4.1.1 Exporting CITs and Relationships from BSM

To retrieve or export CITs and relationships in a service model from BSM/CMDB, you
will be required to perform the following steps:

1. Launch the Business Service Management (BSM) application. For information
about launching and logging in to BSM, refer to the BSM documentation

2. Select Admin & RTSM Administration and then click the
Administration - Package Manager tab

3. The Package Manager window displays
4. Select your RTSM package

5. Click |ﬁ: [Export Packages to local disk]

.
| £| Export package -Telecom.zip [&

Choose the directory to which the package will be exported.

File Mame

Export to directory | ﬁ

(®) Export whole package

() Export resources

= — — —

6. Select the destination directory by clicking [...] and then click [OK] to export
the service model package to the selected destination.
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You will need to export the Telco Universe model if any other model has
PN a relationship with the Telco Universe model. To export the Telco
N\ Universe model, you will be required to select Telecom package from
the Package Manager list.

The service model package is exported as a .ZIP format file.

4.1.2 Exporting Content Pack from BSM

To retrieve or export HIs, HI assignments, KPIs, Business Rules, and Business Rules in a
Content Pack from BSM/RTSM, you will be required to perform the following steps:

1. Launch the Business Service Management (BSM) application. For information
about launching and logging in to BSM, refer to the BSM documentation

Select Admin 2 Platform and then click the Content Packs tab
The Content Packs Manager window displays
Select your Content Pack

AR

Edit it to verify its contents

Click E_-I*:IJ [Export Content Pack Definition and Content]
7. Specify the directory and File name (.XML)
8. Click [SAVE]

o

4.2 Translating a Service Model

A Reverse Transducer can convert BSM service model or content pack files into UML
recognized model which is used in Together. Following previous guide, you have retrieved
all the required components of the service model as .ZIP files, and Content Packs as
XML file, then move them to the one folder which will be input folder of the
ReverseTransducer.bat command-line tool. An example of the Reverse Transducer input
folder is shown in the following figure:

ReverseTransduce.bat Usage:

ReverseTransduce

-folder/-f <BSM_XML_ directory> —target/-t <Together XMI file>
OR

ReverseTransduce

-zipfile/-z <zipfilel.zip; ..;zipfileN.zip> -cp

<content_pack_file1 .xml;. . ;content pack fileN.xml> —target/-t
o <Together XMI file>
OR

ReverseTransduce

-zipfile/-z <zipfilel.zip;..;zipfileN.zip> —-target/-t <Together XMI
file>

OR

ReverseTransduce

—cp <content pack filel.xml;..;content pack fileN.xml> -target/-t
<Together XMI file>

The parameter explanation:
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[-folder/-f <BSM XML directory>]: a folder as the input of the command, it mean

all resource package zip files and content package are put under this folder, the structure
should be:

--folder
--modell.zip
--model2.zip

--modelN.zip
--cpl.xml
--cp2.xml

--cpN.xml
-zipfile/-z <zipfilel.zip;..;zipfileN.zip>: specify the zip files explicitly,
multi files should be separated by semicolon
-cp <content pack filel.xml;..;content pack fileN.xml>: specify the
content files explicitly, multi files should be separated by semicolon.
You can just specify the zip files or cp files or both of them.
—target/-t <Together XMI file>: mandatory, the output file.

Here are some examples:
>ReverseTransduce -folder /test -target mytest.xmi

>ReverseTransduce -zipfile /test/sid.zip;/test/mgt.zip -cp
gadvisor.xml;temip.xml —target mytest.xmi

>ReverseTransduce -z /test/sid.zip;/test/mgt.zip -target mytest.xmi
>ReverseTransduce -cp gadvisor.xml;temip.xml -t mytest.xmi

>ReverseTransduce -z /test/sid.zip;/test/mgt.zip -cp
gadvisor.xml;temip.xml -t mytest.xmi

The output of this command is an xmi file, and after you import the xmai file into a
together UML2.0 project, the structure should be as below:

Under the project, two top level package will be created: Service Models, Service
Repository, and under the service model package, build one sub package for each zip file,
and under the Service Repository package, build one sub package for each content pack
file. Here is an example:

--Project
--Service Models
--Shared Information Model
--<CIT Hierarchy>
--TeMIP Management Modle
-<CIT Hierarchy>
--Service Repository

--QAdvisor

-- <HI, KPIs ...>
--TeMIP

-- <HI, KPIs ...>

Note: currently, all CIT in one zip will be put under the relevant package in the same
level.
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4.3 Importing and Viewing a Service Model in

UML

Once the BSM/RTSM service model is successfully converted to a UML-recognized model,
you can import it in Together in a UML package and view it as a UML model. To import
and view a converted service model in Together, you will be required to perform the

following steps:

1. Launch Together to import and view the converted service model.

2. Create a new UML project. For information about creating a new UML

project, refer to 1.1.1 Enabling the Telecom Universe Profile.
3. Select File 2 Import. The Import window displays.

& Import »

= | B ||

Select
Import Model from XMI File

Select an import source:

type filter text

\

=2

[@] BPEL4WS

(5 DB schema from ER Logical Diagram Profile UML 2.0 project
45 DB schema from JDBC

53 DB schema from S0L script

E:‘?' Pattern conversion profiles

&l Profile Plug-ins

<& Project from MOL file

#* Project from MDX file

Q Together Project =
ZZ, XMIFile
> [ Plug-in Development
» [ Run/Debug
> = Team
- = XML 1
@ < Back Mext = Einish

4. Select XMI File as the import source and then click [Next]

5. The XMI Import window displays

Select source file.

Choutputimobileservices.xmi

Select destination project.

& XMl Import S =HACAC X
Import Project from XMl File JE
Select XMI File To Import T3y

= ey
25iMobile Services

] [ Cancel
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Click [Browse] and browse to the location of the .XMI file generated by the
Reverse-Transducer procedure.

Select an existing project from the Select destination project list. The
imported model will be saved in the selected project.

Click [Finish] to complete the import and view the service model.
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Chapter 5

Troubleshooting and
License Management

This chapter deals with different aspects of troubleshooting during the course of
performing various operations using the Service Designer solution. It consists of detail on
how to configure Service Designer to complement troubleshooting procedures. This
chapter also explains the procedure of installing or updating official license for Service
Designer.

5.1 Configuring Error Tracing

To configure the error tracing mechanism which is activated during the use of
Transducer and Reverse-Transducer procedures to log various types of errors, you will be
required to perform the following steps:

1. Browse to the location on your system where you have installed Service
Designer.

Page 48/59



2. The following figure shows an example of the default installation path.

G-

By Organize ~

-

L« hp b S
- s =

QM+ Service_Designer » v | +4

Folders v | Mame =
&, pccoE) + | |l config
.. Borland Al ., dimensicns
L HP L jre
. Intel = L ik
. MobileServices . log
| PerfLogs .. rulemap
./ Program Files J test
. Actividentity ~/ Uninstall
., Adobe || dimensions,dtd e
. Analog Devices || rulemap.dtd
. Apple Software Update | |InstallationStatus
. Common Files || ReverseTransduce.bat.mine
\ DAP || Transduce.bat.mine
L Divk || build.properties
. DivX Free Codec i
. Google || prefilterlogdj.properties
. Hewlett-Packard || ReverseTransduce bat.r2506
. hp || Transduce.bat.r2506 |
LSOM || ReverseTransduce.bat.r2520
| Service_Designer + | L Transduce.bat.r2520

logdj.properties Date modified: 10/27/2009 6:08 PM
PROPERTIES File

I W

Search yel
 eee—

-

vs ~ & Open & Burn

|| re-transduce.report

|| transduce.report

| errorlog

 Version.bd
ReverseTransduce.bat

ET:' ReverseTransducedtest.hat
< 11

Size: 809 bytes
Date created: 11/30/2009 12:38 PM

3. Open Log4j.properties file in a suitable editor (such as, MS Notepad).

4. The content of the file displays in the editor window. An example is shown in
the figure below.

E logdj.properties -

A gErs

Notepad A

File Edit Format

View Help

log4]. appender
log43. appender

log4j.appender
log4]. appender
log4]. appender

# Keep three backu

log4j. appender

# For JBoss: Avoid to setup Logd] outside
$1B0SS_HOME/server /default/deploy/1 ogd'Fil. xml!
# For all other servers: e

Logdd.
stdout, TogFile
og4]. appender. stdout=org. apache. 1 og4g’l. ConsoleAppender
e

- rootLogger=DEBUGH

comment out the Log4l Tistener in web.xml to activate

.stdout. layout=org. apache. Togdj.PatternLayout
.stdout. layout.ConversionPattern=%d %p [%c] - <%m=%n

. logfile=org. apache. Tog4j. rol11ingrFileappender
. logfile. F'i?e=. /log/transducer. 1og

. logfile.MaxFilesize=2MB

files.

le.MaxBackupIndex=100

. 1091E"i

# Pattern to output: date priority [category] - message
. logfile. Tayout=org. apache. Tog4 j. PatternLayout
.logfile. layout.ConversionPattern=%d %p [%c] - %m%n

log4j. appender
log4j. appender

5. You can configure the level of traces for the Transducer and Reverse-
Transducer procedures by editing the log4j.rootLogger property. By default
the level is set to ERROR. You can change this value to one of the following
levels, as appropriate:

Page 49/59



FATAL

ERROR

WARN

INFO

DEBUG

TRACE

Severe errors that cause premature termination. Expect
these to be immediately visible on a status console.

Other runtime errors or unexpected conditions. Expect
these to be immediately visible on a status console.

Use of deprecated APIs, poor use of API, 'almost' errors,
other runtime situations that are undesirable or
unexpected, but not necessarily "wrong". Expect these to
be immediately visible on a status console.

Interesting runtime events (startup/shutdown). Expect
these to be immediately visible on a console, so be
conservative and keep to a minimum.

Detailed information on the flow through the system.
Expect these to be written to logs only.

More detailed information. Expect these to be written to
logs only.

5.2 Configuring Log Generation

To configure the location where the error log will be generated during execution of the
Transducer and Reverse Transducer procedures, you will be required to perform the

following steps:

1. Browse to the location on your system where you have installed Service
Designer. The following figure shows an example of the default installation

path.

-
@uq |« hp » SQM b Service Designer » - [ 42 ||| Search =

Wy Organize ~ Views

Folders
&, PC COE (C)
| Borland
HP
Intel
| MobileServices
PerfLogs
Program Files
| ActivIdentity
Adobe

Analog Devices

Common Files
DAP

| DivK
DivX Free Codec
Google

| Hewlett-Packard
hp

sQmM

~ Bl Open

| Apple Software Update || InstallationStatus

. Service_Designer - | | Transduce.bat.r2520

» log4j.properties Date modified: 10/27,/2009 6:08 PM
_] PROPERTIES File

~ | Name
- config
| dimensions
jre
lib
llog
L ralemap

test

Uninstall

| dimensions.dtd

| rulemap.dtd

m

| ReverseTransduce.bat.mine
| Transduce.bat.mine

|7 build.properties

|7 prefilterlogd).properties

| | ReverseTransduce.bat.r2506
| Transduce.bat.r2506

|| ReverseTransduce.bat.r2520

| re-transduce.report
|_transduce.report

| emorlog

[ version.bxt

@i ReverseTransduce.bat

@ ReverseTransducedtest. hat
< [T

Size: 809 bytes
Date created: 11/30/2009 12:38 PM

2. Open Log4j.properties file in a suitable editor (such as, MS Notepad).

Page 50/59



3. The content of the file displays in the editor window. An example is shown in

the figure below.

| logdj.properties - Notepad

‘_D|IE|-§3—

File Edit Format View Help

# For JBoss: Avoid to setup Log4] outside
$31B055_HOME/server /default/dep oyf'logrigl.xnﬂ!
# For all other servers: Comment out the

Tog4j.rootLogger=DEBUG, stdout, logfile

log4]. appender.stdout=org. apache. 10g4—ﬂ'|. Consoleappender

log4]. appender. stdout. Jayout=org. apache. Tog4j. PatternLayout

log4]. appender. stdout. Tayout. ConversionPattern=%d %p [%c] - <%m=%n

log4j.appender.logfile=org. apache. log4j.Ro17ingFilesppender
|

log4j. appender. logfile.MaxF1les1ze=2MB

# Keep three backup files.

log4j. appender. logfile.maxBackupIndex=100

# Pattern to output: date priority [category] - message

log4j. appender. logfile. layout=org. apache. log4j. PatternLayout
log4]. appender. logfile. layout.ConversionPattern=%d %p [%c] - %m%n

Log43 Tistener in web.xml to activate

4. You can edit the value of the log4j.appender.logfile.File property, as
appropriate. For example, if this property is set to ./log/transducer.log, it
means that the error log will be saved as transducer.log in a new folder
called log which will be created in the current installation folder of Service

Designer.

5.3 Managing Licenses

To install or update a new license for Service Designer, you will be required to perform

the following steps:

1. Launch the Windows Command Prompt from the Start menu and enter the
Service Designer installation directory. An example is shown in the figure

below.

EX Administrator: C\Windows\system32\cmd.exe

C:~>cd C:n\Program Files“hp~2QM~Service_Designer

C:“Program Files“hp:S8QM:Service_Designer>_

=B .
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2. Execute the License.bat command by entering required parameters i.e. —add
<license file path>. The license file path must contain a valid license file. An

example is shown in the figure below.

B Administrator: C\Windows\system32\cmd.exe |ﬂlﬁ

c :“Program Files“hp:\SQM~Service_Designer>license —add "C:\Users\naquika\Desktop\l’

license~20100210.txt""
License Import SUCCESS
Expiration Date: 2018.82.18

c :“\Program Files“hp:S8QM:\Service_Designer>

4

"3

3. Press [Enter] to execute the License.bat tool, which will install the selected
license for Service Designer and show a confirmation message along with the
date of expiration for the installed license.

License.bat Usage:
C:>License [-options]
where options include:
-help {print the help text}

-add <license file path> {specify the location of the license file to
be imported}
-GUI {Pop a GUI to perform the license management operations}.
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Appendix A

This section contains the mapping information for different components of a service
model. For each component, a separate table defines the mapping of applicable properties
and their names in BSM (RTSM/BSM Repositories) and UML.

Cl Type

Property in CMDB Property in Together UML Type

Display Name Properties -> Name String
Derived-From class-name Properties -> Extends String
Name Telecom Universe Profile -> Identifier String
Qualifiers Telecom Universe Profile -> Qualifiers String
Icon Telecom Universe Profile -> Icon Name String
Default Label Telecom Universe Profile -> Label Format | String
Description Description String
CIT Attribute

Property in CMDB Property in Together UML Type
Attribute Name Telecom Universe Profile -> Identifier String
Display Name Properties -> name String
Type Properties -> type String
Default Value Properties -> default value String
Editable (=false) Properties -> read only Boolean
Static (=true) Properties -> static Boolean
Unique (=true) Properties -> is unique Boolean
Index (=true) Telecom Universe Profile -> Index Boolean
Key (=true) Telecom Universe Profile -> Key Boolean
Required (=true) Telecom Universe Profile -> Required Boolean
Visible (=false) Telecom Universe Profile -> Visible Boolean
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Property in CMDB

Property in Together UML

Asset Data (=true) Telecom Universe Profile -> Asset Data Boolean
Comparable Telecom Universe Profile -> Comparable Boolean
Change Monitored (=true) Telecom Universe Profile -> Change Monitored Boolean
Telecom Universe Profile -> Enable Auto Truncate
Enable Auto Truncate by DDM (=true) by DDM Boolean
Upper Case (=true) Telecom Universe Profile -> Upper Case Boolean
Lower Case (=true) Telecom Universe Profile -> Lower Case Boolean
Password (=true) Telecom Universe Profile -> Password Boolean
Value Size Telecom Universe Profile -> Size Integer
Description Description String
CIT Attribute Override
Property in CMDB Property in Together UML Type ‘
Attribute Name Telecom Universe Profile -> Identifier String
Default Value Properties -> default value String
Editable (=false) Properties -> read only Boolean
Static (=true) Properties -> static Boolean
Unique (=true) Properties -> is unique Boolean
Index (=true) Telecom Universe Profile -> Index Boolean
Key (=true) Telecom Universe Profile -> Key Boolean
Required (=true) Telecom Universe Profile -> Required Boolean
Visible (=false) Telecom Universe Profile -> Visible Boolean
Asset Data (=true) Telecom Universe Profile -> Asset Data Boolean
Comparable Telecom Universe Profile -> Comparable Boolean
Change Monitored (=true) Telecom Universe Profile -> Change Monitored Boolean
Frielslle A Trezs by RRL Telecom Universe Profile -> Enable Auto Truncate
(=true) by DDM Boolean
Upper Case (=true) Telecom Universe Profile -> Upper Case Boolean
Lower Case (=true) Telecom Universe Profile -> Lower Case Boolean
Password (=true) Telecom Universe Profile -> Password Boolean
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Property in CMDB Property in Together UML

Value Size Telecom Universe Profile -> Size Integer

CMDB Relationship

Property in CMDB ‘ Property in Together UML ‘ Type

Class Ref class-name Telecom Universe Profile -> Identifier String
End1l class-name String
End2 class-name String
Valid-Link-Qualifiers Telecom Universe Profile -> Qualifier String

CMDB Relationship Link Triplet

Property in CMDB Property in Together UML Type

class-name Telecom Universe Profile -> Identifier String

Calculated-link-type Telecom Universe Profile ->

(='impact_dependency’) | CalculatedLinkType String
Boolea

is-forward (=true) Telecom Universe Profile -> IsForward n

End1 class-name String

End2 class-name String

Business Rules

Property in CMDB Property in Together UML Type

Telecom Universe Profile ->

ID (DASH/SLM)_Identifier Integer

Display Label Properties -> Name String

Description Description String
Telecom Universe Profile ->

RuleType (DASH/SLM)_RuleType String
Telecom Universe Profile ->

Class Name (DASH/SLM)_JavaClass String

Units Telecom Universe Profile -> (DASH/SLM)_Units | String
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Health Indicators

Property in CMDB Property in Together UML

N/A Properties-->name String

application Properties-->stereotype String

description Description String

artifact id (generated by

transducer) Telecom Universe Profile -> identifier String

CiTypeld Telecom Universe Profile -> CIT String

displayName, Label,

name Telecom Universe Profile --> DisplayName String

units Telecom Universe Profile --> Units String

ServiceHealthIndicatorDat | Telecom Universe Profile -->

a defaultRule DASH_DefaultRule String
Telecom Universe Profile -->

formattingMethod DASH_FormattingMethod String

SLMIndicatorData Telecom Universe Profile -->

defaultRule SLM_DefaultRule String

HI Assignment

Property in CMDB ‘ Property in Together UML

HI Assignment for Dashboard: String
Telecom Universe Profile --> DASH__ Identifier

HI Assignment for SLM:
Telecom Universe Profile --> SLM__ Identifier

assignmentld

displayName Properties-->name String
description Properties-->Description String
_all_izignmentApplication Properties-->stereotype String
HI Assignment for Dashboard: String
Telecom Universe Profile --> DASH_ CIT
Gaierifr Enr HI Assignment for SLM:
Telecom Universe Profile --> SLM_ CIT
HI Assignment for Dashboard: String

Telecom Universe Profile --> DASH__

condition Monitored- MonitoredBy
by HI Assignment for SLM:

Telecom Universe Profile --> SLM_ MonitoredBy
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HI Assignment Configuration

Property in CMDB Property in Together UML

indicatorld Telecom Universe Profile --> HIName String
rule Telecom Universe Profile --> RuleName String
rule-parameter Telecom Universe Profile --> RuleParameters String
fiiTcEedior Telecom Universe Profile --> TrinitySelector String

Key Performance Indicators

Property in CMDB ‘ Property in Together UML ‘ Type
Telecom Universe Profile ->

ID (DASH/SLM)_Identifier Integer

Display Label Properties -> Name String

(depends on the KPI stereotype = DASH or
Applicable Sections SLM) String

Telecom Universe Profile ->
Default Group Rule (DASH/SLM)_GroupRuleld String

Telecom Universe Profile ->
applicableRules (DASH/SLM)_ApplicableRules String

Telecom Universe Profile ->
ID (DASH/SLM)_Identifier Integer

Page 57/59



A

associated
documents -6

Associated documents -6

B

BR tooltip
defining -28
BRs, Hls and KPlIs
Deploying -41
BSM to Together
mapping -53

business rule
defining -26

Calculated Link triplet -23

HI -29
HI Assignment -33

HI Configuration -34

deploying

CIT and relationships -39

service models -36
designing
service models -12

Index

C

Calculated Link triplet
Defining -23
Cl type
defining -17
CIT and relationships
deploying -39
CIT attribute
defining -20
CITs and relationships
exporting -43
configuring
error tracing -48
log generation -50
Content Pack
Creating -25
Exporting -44
creating
service model -17
Creating
Content Pack -25

E

enabling

telecom universe profile -13

error tracing
configuring -48

exporting
CITs and relationships -43
UML model -36
Exporting

Content Pack -44

H

HI
Defining -29
HI Assignment
Defining -33
HI Configuration
Defining -34

D

defining
BR Tool Tip -28
business rule -26
Cl type -17
CIT attribute -20

inheritance relationship -22

KPI -31
relationship -21
Defining

importing
service models -43
Importing

SMF UML workspace -16

importing and viewing
service model -46

inheritance relationship
defining -22

K

KPI
defining -31

L

licenses

Page 58/59



managing -51
log generation
configuring -50

M

managing

licenses -51
mapping

BSM to Together -53

translating -44
service models
deploying -36
designing -12
importing -43
SMF UML workspace
Importing -16

@)

overview
service designer -8

R

relationship

defining -21
retrieving

service model -43
reverse transducer -9

workflow -9

T

telco palette -8
using -12
telecom universe profile
enabling -13
transducer -9
workflow -11
translating
service model -44
UML model -38
troubleshooting -48

S

service designer
components -8
overview -8
workflows -9
service model
creating -17
importing and viewing -46
retrieving -43

U

UML model
exporting -36
translating -38

using
telco palette -12

W

workflow
reverse transducer -9
transducer -11

Page 59/59



	SQM Service Designer V3.0 User Guide
	Edition: 2.0
	Legal Notices
	Contents
	Preface
	Intended Audience
	Abbreviations and Acronyms
	Associated documents
	Typographic Conventions
	Symbols Used in this Guide
	Support
	Chapter 1
	Service Designer Overview
	1.1 Service Designer Components
	1.1.1 Telco Palette
	1.1.2 Transducer
	1.1.3 Reverse-Transducer

	1.2 Service Designer Workflows
	1.2.1 Reverse-Transducer Workflow
	1.2.2 Transducer Workflow


	Chapter 2
	Designing  Service Models
	2.1 Using the Telco Palette
	2.1.1 Enabling the Telecom Universe Profile

	2.2 Importing SMF UML workspace
	2.3 Creating a Service Model
	2.3.1 Defining a CI Type
	2.3.2 Defining a CIT Attribute
	2.3.3 Defining a Relationship
	2.3.4 Defining an inheritance Relationship
	2.3.5 Defining a Calculated Link triplet
	2.3.6 Creating a link for Existing CIT

	2.4 Creating a Content Pack
	2.4.1 Defining a Business Rule
	2.4.1.1 Defining a Business Rule Tool Tip Parameter

	2.4.2 Defining an Health Indicator
	2.4.3 Defining a Key Performance Indicator
	2.4.4 Defining an HI Assignment
	2.4.4.1 Defining an HI Configuration



	Chapter 3
	Deploying  Service Models in BSM
	3.1 Exporting a UML Model
	3.2 Translating a UML Model
	3.3 Deploying a Service Model in BSM
	3.3.1 Deploying CITs and Relationships in BSM
	3.3.2 Deploying BRs, HIs and KPIs in BSM


	Chapter 4
	Importing Service Models in UML
	4.1 Retrieving a Service Model
	4.1.1 Exporting CITs and Relationships from BSM
	4.1.2 Exporting Content Pack from BSM

	4.2 Translating a Service Model
	4.3 Importing and Viewing a Service Model in UML

	Chapter 5
	Troubleshooting and License Management
	5.1 Configuring Error Tracing
	5.2 Configuring Log Generation
	5.3 Managing Licenses

	Appendix A
	Index

